What's New in ArcView 3.1, 3.2, and 3.3

An ESRI® White Paper • June 2002
## What's New in ArcView 3.1, 3.2, and 3.3

**An ESRI White Paper**

### Contents

<table>
<thead>
<tr>
<th>Application Level</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start-Up Screen Dialog</td>
<td>2</td>
</tr>
<tr>
<td>Project Update for Existing Projects</td>
<td>2</td>
</tr>
<tr>
<td>Expanded Date Support</td>
<td>2</td>
</tr>
<tr>
<td>Support for PC ARC/INFO Double-Precision Coverages</td>
<td>3</td>
</tr>
<tr>
<td>Improved Support for ArcInfo Line Symbols</td>
<td>3</td>
</tr>
<tr>
<td>New TrueType Fonts and Symbols</td>
<td>3</td>
</tr>
<tr>
<td>Import Multilayer ArcInfo Line Symbols</td>
<td>3</td>
</tr>
<tr>
<td>Import ArcInfo LineType Marker Symbols</td>
<td>3</td>
</tr>
<tr>
<td>Customize ArcView</td>
<td>3</td>
</tr>
<tr>
<td>Extension .apr Files Available</td>
<td>3</td>
</tr>
<tr>
<td>ArcView Projection Utility</td>
<td>4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Views and Themes</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Properties</td>
<td>4</td>
</tr>
<tr>
<td>Background Color</td>
<td>4</td>
</tr>
<tr>
<td>Setting Projection for Already-Projected Data</td>
<td>5</td>
</tr>
<tr>
<td>TOC Style</td>
<td>5</td>
</tr>
<tr>
<td>Label and Text Tools</td>
<td>5</td>
</tr>
<tr>
<td>Default Settings for Text and Label Tools Dialog</td>
<td>5</td>
</tr>
<tr>
<td>Spline Text Tool</td>
<td>6</td>
</tr>
<tr>
<td>Convert Shapefiles to Projected Units</td>
<td>6</td>
</tr>
<tr>
<td>Adding Themes</td>
<td>6</td>
</tr>
<tr>
<td>Adding Already-Projected Data to a Projected View</td>
<td>6</td>
</tr>
<tr>
<td>ESC Cancels Directory Scan for Add Theme</td>
<td>6</td>
</tr>
<tr>
<td>Map and Distance Units Automatically Set</td>
<td>6</td>
</tr>
<tr>
<td>New View Menu Options</td>
<td>6</td>
</tr>
<tr>
<td>Manage Data Sources Under View Menu</td>
<td>6</td>
</tr>
<tr>
<td>Save Project As and Extensions Under File Menu</td>
<td>7</td>
</tr>
<tr>
<td>Create Buffers Wizard</td>
<td>7</td>
</tr>
</tbody>
</table>
Contents

Views Can Be Exported into JPEG Format..................................... 7
ESC Stops Drawing of Themes .................................................... 7

Data Integration Utilities.............................................................. 7
SDTS Data Import ................................................................. 7
DXF Export................................................................................. 7

Creating and Editing Spatial Data.................................................. 7
Shape Properties Dialog........................................................... 7
Snap Tolerance Cursor.............................................................. 8
Introducing Measured and Three-Dimensional Shapes............. 8
  What Are Measured and Three-Dimensional Shapes?........... 8
Improved Support for Dynamic Segmentation....................... 9

Tables......................................................................................... 9
What's New for SQL Connect .................................................... 9

Printing and Layouts.................................................................. 10
Neatline Button........................................................................... 10
Layouts Can Be Exported into JPEG Format ......................... 10

Extensions................................................................................ 10
CAD Reader Extension.............................................................. 11
Database Access Extension....................................................... 11
Dialog Designer Extension......................................................... 11
Digitizer Extension...................................................................... 12
  Stream Tolerance.................................................................... 12
  Enable/Disable Stream Mode ............................................. 12
GeoProcessing Extension.......................................................... 12
  Dissolve Features Based on an Attribute......................... 13
  Merge Themes Together.................................................. 13
  Clip One Theme Based on Another................................. 13
  Intersect Two Themes..................................................... 13
  Union Two Themes......................................................... 13
  Assign Data by Location.................................................. 14
Graticules and Measured Grids Extension............................... 14
ERDAS IMAGINE Image Extension ............................................. 15
JPEG (JFIF) Image Support Extension...................................... 15
Legend Tool Extension.............................................................. 15
Military Data Reader Extensions............................................. 15
MrSID Image Support Extension.............................................. 16
## Contents

<table>
<thead>
<tr>
<th>Extension</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Writer Extension</td>
<td>16</td>
</tr>
<tr>
<td>TIFF 6.0 Image Support Extension</td>
<td>17</td>
</tr>
<tr>
<td>VPF Viewer Extension</td>
<td>17</td>
</tr>
<tr>
<td>Optional Extensions to ArcView</td>
<td>18</td>
</tr>
<tr>
<td>ArcView 3D Analyst Extension</td>
<td>18</td>
</tr>
<tr>
<td>ArcPress for ArcView Extension</td>
<td>18</td>
</tr>
<tr>
<td>ArcView Business Analyst Extension</td>
<td>18</td>
</tr>
<tr>
<td>ArcView Image Analysis Extension</td>
<td>18</td>
</tr>
<tr>
<td>ArcView Image Analysis Extension</td>
<td>20</td>
</tr>
<tr>
<td>ArcView Network Analyst Extension</td>
<td>21</td>
</tr>
<tr>
<td>ArcView Spatial Analyst Extension</td>
<td>22</td>
</tr>
<tr>
<td>ArcView StreetMap Extension</td>
<td>23</td>
</tr>
<tr>
<td>ArcView StreetMap 2000 Extension</td>
<td>23</td>
</tr>
<tr>
<td>ArcView Tracking Analyst Extension</td>
<td>24</td>
</tr>
<tr>
<td>ESRI Data &amp; Maps</td>
<td>24</td>
</tr>
<tr>
<td>Samples</td>
<td>25</td>
</tr>
<tr>
<td>ArcView Connect for R/3 Extension</td>
<td>25</td>
</tr>
<tr>
<td>ArcView R/3 Interface Project</td>
<td>25</td>
</tr>
<tr>
<td>Map Labeling Extension</td>
<td>25</td>
</tr>
<tr>
<td>MGE Reader Extension</td>
<td>26</td>
</tr>
<tr>
<td>DIGEST (ASRP/USRP)</td>
<td>26</td>
</tr>
<tr>
<td>MGRS Coordinate Display</td>
<td>26</td>
</tr>
<tr>
<td>S-57 Data Converter</td>
<td>26</td>
</tr>
<tr>
<td>RPF Indexer</td>
<td>27</td>
</tr>
</tbody>
</table>
What's New in ArcView 3.1, 3.2, and 3.3

Welcome to ArcView® 3.x. Whether you are an experienced user or getting started with ArcView 3.x, this white paper will introduce you to all of the new features and capabilities of ArcView 3.x.

Each new release exemplifies ESRI's commitment to enhancing the user experience with ArcView. ArcView 3.1 introduced a wizard-based approach to accomplish a variety of more sophisticated tasks such as advanced map production and advanced geoprocessing. Task wizards, along with other updates focusing on enhancing usability, leverage the power of ArcView to help you more quickly and easily accomplish your geographic information system (GIS) objectives.

ArcView 3.1 also introduced several new included extensions, specifically designed to supplement your GIS requirements. In particular, ArcView features a report writer extension that enables you to easily generate professional reports, including embedded maps and charts, that help you more successfully communicate the results of your GIS analysis.

ArcView 3.2 provided both strategic updates to existing capabilities as well as new tools to facilitate your GIS operations. Specifically, ArcView 3.2 included an updated report writer and significant database access improvements. ArcView 3.2 also introduced a new shapefile projection utility, providing support for an extensive range of data projections and datum transformations, as well as support for several new data formats.

ArcView 3.3 provides key updates to many of the tools that are part of ArcView. ArcView 3.3 includes updates to many extensions including CAD Reader, ERDAS IMAGINE® Image Reader, and the National Imagery Transmission Format (NITF) Data Reader. Also, the Projection Utility has been enhanced for greater performance. The Report Writer has been updated to include Crystal Reports™ 8.5 by Crystal Decisions. Database Access 2.1c is also included to support the latest ArcSDE™ database and provide direct connections to ArcSDE data.

ESRI Data & Maps has also expanded to eight CDs full of new and updated data.
Application Level

Start-Up Screen Dialog

Created with new users in mind, this dialog gives quick and easy access to some of the most common tasks performed when starting ArcView. You can choose to create a new project (either blank or with a view) or open an existing one. Clear the check box to stop the dialog from displaying when ArcView opens.

![Start-Up Screen Dialog](image)

If you do not want the dialog displayed again, delete the avstart.txt file in your TEMP directory (PC) or $HOME directory (UNIX).

Project Update for Existing Projects

When opening a project that has a customized interface (i.e., the project uses one of ESRI's optional extensions or contains changes to buttons, tools, or menus through the use of the Customize dialog box) and was created using ArcView 3.0 or 3.0a, ArcView will show the following message box:

![Project Update Dialog](image)

To update your project, click Yes. The new version 3.1 tools will be added to your interface. To leave your project as is, click No. Your project will not be updated.

Expanded Date Support

The supported range of the value of the Date class in ArcView is no longer limited to 1970 to 2038. ArcView now supports a date range from 4715 B.C. to 9999 A.D. While dates beyond this range may work, they may not produce consistent results for all Avenue™ requests.

ArcView will recognize dates from January 1, 0000, to December 31, 9999, in dBASE® files and from January 1, 1000, to December 31, 9999, in INFO™ files. Dates outside this range are given a value of null when retrieved from a table. Delimited text files store dates as strings that can be converted to dates with Avenue software. This means the delimited text file date range is the same as the Avenue Date class range.
Support for PC ARC/INFO Double-Precision Coverages

One of the new features in PC ARC/INFO® 4.0 is the ability to create double-precision coverages. Support for direct read of these coverages has been added in ArcView 3.3. Note: ArcView 3.3 cannot access PC ARC/INFO single- and double-precision coverage types when mixed in a single workspace. Whichever type ArcView first encounters is the type that will be used for the entire workspace.

Improved Support for ArcInfo Line Symbols

Prior to version 3.1, ArcView could not display some types of ArcInfo™ line symbols—particularly custom symbols such as multilayer or LineType Marker. Now most ArcInfo line symbols can be used in ArcView.

New TrueType Fonts and Symbols

New and enhanced symbol palettes include

- **Geology.avp**: nearly 300 line and marker symbols for making U.S. Geological Survey (USGS)-compliant geologic maps
- **Weather.avp**: additional weather frontline symbols
- **Transp.avp**: additional railroad line symbols
- **Forestry.avp**: line and marker symbols for creating forest firefighting maps

Import Multilayer ArcInfo Line Symbols

You can now import multilayer ArcInfo line symbols into ArcView. Even if you do not have access to ArcInfo, you can create your own symbols using new Avenue classes added to support these new capabilities. For more information, refer to the "symbols, how to create complex line symbols using Avenue" topic in the ArcView online help index.

Import ArcInfo LineType Marker Symbols

You can also import LineType Marker and LineType VertexMarker from ArcInfo symbolsets. The ArcInfo marker symbols you import must already be defined using TrueType® fonts. (This capability became available in ArcInfo 7.1.) You will need to create a new version of the TrueType font and name it appropriately so that ArcView can match the information in the LineSet file and use the correct font and character for your font.

If the ArcInfo symbol was created using the older IGL font technology, ArcView will still import the symbol, including all of its properties, except the marker symbol. The current default marker symbol in ArcView will be used, but you can use Avenue to substitute one that is more appropriate. For script examples, refer to the "symbols, Avenue examples" topic in the ArcView online help index.

Customize ArcView

Extension .apr Files Available

The $AVHOME\samples\ext directory contains the project files used to create the extensions listed above. You can customize the extensions by editing the project files and creating new versions of the extensions.
ArcView Projection Utility

ArcView 3.2 introduced a utility that enables users to project shapefiles into a common coordinate system. The projection utility supports an extensive array of projections as well as datum conversions (including NAD27 to NAD83). The projection utility includes a wizard-driven interface that guides you through the process of selecting the input theme or data source to be projected, accepting default or setting custom projection parameters, and specifying the output theme or data source name. The utility creates a new shapefile and a metadata file that contains information about the current projection parameters for the new shapefile.

ArcView 3.3 includes an updated ArcView Projection Utility built upon the new components in MapObjects® 2.1. The updated Projection Utility offers faster projecting and reprojecting of shapefiles as well as faster start-up times for the utility.

The Shapefile Projection Utility can be launched from the ArcView user interface as an extension or can be run as a stand-alone utility. The ArcView projection utility is not available on UNIX®.

Views and Themes

View Properties

Background Color

A new button on the View Properties dialog allows you to change the view's background color. From the View menu, choose Properties, and then click Select Color. The new background color will be maintained when displayed in a layout.
Setting Projection for Already-Projected Data

When you are adding projected data as a theme, ArcView will detect whether it is projected and prompt you to set your view’s projection. You are not prompted if the extent of themes is beyond the standard geographic coordinates.

TOC Style

A new menu choice, TOC Style, has been added to the View’s View menu. TOC Style lets you change the following display settings of the Table of Contents (TOC):

- Line flatness (degree to which the line symbols in the legend are flat)
- Symbol length (the length of the line symbol in the TOC)
- TOC text symbol (how text in a legend appears)

Label and Text Tools

Default Settings for Text and Label Tools Dialog

ArcView 3.1 upgraded the Label tool and the Text tool as tool menus with additional options for placing labels and text in a view or layout. These menus are expanded to support the following new capabilities:

- Labeling with a leader line pointing to a feature
- Labeling using banners
- Labeling using callouts
- Labeling with a background and drop shadow
- Labeling highways with standard highway shield symbols

Default settings can be changed using the new Default settings for text and label tools dialog, accessible from the Graphics menu. When you click on one of the icons, options associated with the tool appear in the menu.
A sample extension for autolabeling more than one theme is also included.

**Spline Text Tool**
A new Spline text tool with the ability to align text or position it along curved lines has been added in this release. The tool is presented as an option on the Text tool menu. After indicating where you want text drawn (by clicking in your view or layout), use the Spline Text Properties dialog to enter, align, and draw your text.

**Convert Shapefiles to Projected Units**
For projected views, Convert to Shapefile will now ask you if you want the new shapefile to be created in projected units. Previously, Convert to Shapefile only output the new shapefile in decimal degrees for projected views. (For nonprojected views, the new shapefile was and still will be created in the units of the base data.)

**Adding Themes**

**Adding Already-Projected Data to a Projected View**
Add Theme will now warn you if you try to add already-projected data to a projected view (unless you are adding images). The data will be added to the view anyway, but it may not display properly because you cannot view already-projected data in a projected view.

**ESC Cancels Directory Scan for Add Theme**
ESC cancels the directory scan for Add Theme. This allows you to immediately stop ArcView from reading all the directories. For example, if you have a folder with 40 folders in it and you want to go to the third in the list, wait for ArcView to display the first three folders, then press ESC. Now double-click on the third folder in the list.

**Map and Distance Units Automatically Set**
When adding a theme, if ArcView detects that your data is in decimal degrees, the map and distance units will automatically be set.

**New View Menu Options**

**Manage Data Sources Under View Menu**
A new menu choice, Manage Data Sources, has been added to the View's File menu. Manage Data Sources lets you copy, rename, and delete shapefiles.
Save Project As and Extensions have been added to the View's File menu to make these options more accessible. (They have also been added to the interfaces of the other document types such as the Layout's File menu, the Project's File menu, and the Table's File menu.)

Create Buffers Wizard

Accessed from the View's Theme menu, this wizard provides an easy-to-use set of panels for creating buffers. Using the panels, you will be able to select what and how to buffer, set buffer options, and specify where output should be saved.

Views Can Be Exported into JPEG Format

Views can now be exported into JPEG format.

ESC Stops Drawing of Themes

Pressing ESC will immediately stop the drawing of themes without clearing the view's display. (To support this functionality, the ESC accelerator to turn off all themes has been removed.)

Data Integration Utilities

SDTS Data Import

ArcView 3.2 included a data import utility that imports Spatial Data Transfer Standard (SDTS) raster and point data and creates ESRI® GRID files and ArcView point shapefiles, respectively. At ArcView 3.3, the SDTS raster import utility has been updated to support the latest raster profile types released by the USGS.

DXF Export

ArcView 3.2 included a data conversion utility providing shape to DXF output.

Creating and Editing Spatial Data

Shape Properties Dialog

This dialog was added to ArcView to support interactive addition, deletion, and editing of shape vertices. The main dialog identifies the type of shape and the number of vertices and presents a list of vertices within the shape. You can choose to add a
vertex to a shape or select multiple vertices and delete them. The dialog is available from a right-click popup menu when a shape is selected and editable.

**Snap Tolerance Cursor**

When general or interactive snapping is turned on, you have the option of displaying a circle representing the snap tolerance with the cursor as you create polylines, polygons, or edit vertices. This is known as the snap tolerance cursor. If general snapping is turned on, the circle represents the general snap tolerance. If interactive snapping is also turned on, the circle will change to the interactive snap tolerance cursor when you choose an interactive snap rule. By default, the snap tolerance cursor is turned on when snapping is turned on. You can turn the snap tolerance cursor off in the Editing panel of the Theme Properties dialog or by using the Show/Hide Snap Tolerance Cursor toggle on the View's popup menu.

**Introducing Measured and Three-Dimensional Shapes**

ArcView 3.1, 3.2, and 3.3 provide support for measured and three-dimensional data by extending existing ArcView shape classes and providing an Avenue application program interface (API) for accessing the measure and elevation values.

This means that data created by users of the ArcView 3D Analyst™ extension can be displayed and queried in two dimensions by all users of ArcView 3.1, 3.2, and 3.3.

**What Are Measured and Three-Dimensional Shapes?**

ArcView has always stored geometric shapes using x,y coordinates. Points are recorded as a single x,y coordinate pair, lines as a series of ordered x,y coordinates, and areas (polygons) as a series of x,y coordinates defining a set of line segments that have the same start and end points.

ArcView has extended the way it stores shapes. Instead of simply storing x,y coordinates that define a shape, a shape can additionally store a measure value "m" and/or an elevation value "z" at each x,y. Therefore, one or more (x,y,m), (x,y,z), or (x,y,z,m) coordinates can represent each geometric feature.
Improved Support for Dynamic Segmentation

All dynamic segmentation functionality available for coverage route systems in previous versions of ArcView is now available on measured PolyLine shapefiles (i.e., a PolyLineM or a PolyLineZ with the optional measure values attached).

The extended dynamic segmentation functionality includes the following:

- The DynName class now accepts a measured PolyLine shapefile FTab on the Make request.
- The Add Event Theme dialog now recognizes measured PolyLine shapefiles—that is, event themes can be defined on measured shapes.
- The FTab requests ReturnLocation and ReturnRouteMeasure now work on measured PolyLine shapefiles.
- The Export request on the FTab class can now convert an ArcInfo coverage route system into a measured (PolyLineM) shapefile.

Tables

What’s New for SQL Connect

With PC versions of ArcView, error messages returned from an ODBC driver are now appended to a file called ODBC.errlog located in the ArcView home directory. Error messages associated with incorrect login information, select statement syntax errors, or attempting to perform an invalid database operation are normally returned from a driver. If the ODBC.errlog file does not exist, you will get a message stating that the file has been created the first time a driver returns an error message. Below is an example of an error message that may appear in this file.

Call to SQLPrepare received error ODBC API function called
Received: SQL_ERROR Return code from the ODBC function
Return code: -1
State: S0022 ODBC error code—If you have ODBC API documentation, you can retrieve more information about the problem by looking up this SQL State.
Error: [INTER SOLV] [ODBC Oracle driver] [Oracle] ORA-00904: invalid column name Error code and error message from the database
Printing and Layouts

Neatline Button

A neatline defines the map's frame. A border is composed of an additional line or lines that are parallel to the neatline. They are often used to provide the outer limit of the map or just to provide a decorative element. ArcView 3.1, 3.2, and 3.3 include a Neatline button on the layout interface that provides several options for adding a neatline to your map. You can control the placement of a neatline by specifying whether it should be drawn around all graphics, selected graphics, or inset from the margins of a page. You can also vary the appearance of a neatline by changing its line style, width, and corner shape. Additionally, you can add background color and drop shadows.

To create neatness and borders on your layout, use the Neatline button available in the button bar. Once selected, the Neatline dialog will appear.

Layouts Can Be Exported into JPEG Format

Layouts can now be exported into JPEG format.

Extensions

ArcView extensions are add-on programs that provide specialized GIS functionality. When you load an extension, the ArcView user interface changes to reflect the functionality available in the extension. New menus, buttons, tools, and dialog options will be available.

Extensions are loaded and unloaded using the Extensions dialog box. To access the Extensions dialog, choose Extensions from the File menu.
The following extensions are included with ArcView.

**CAD Reader Extension**

CAD Reader extension has been updated to support AutoCAD® 2000 (Release 15) drawing and AutoCAD 2002 drawing and DXF™ files in ArcView 3.3. The extension also supports three-dimensional computer-aided design (CAD) drawings, which can be used with the ArcView 3D Analyst extension, allowing you to add three-dimensional CAD drawings directly into ArcView 3D Analyst (similar to any other three-dimensional theme) for analysis and interactive perspective viewing.

The CAD Reader extension is not available on UNIX.

**Database Access Extension**

The Database Access extension provides multiuser, client/server access to spatial and nonspatial data stored in relational databases. You can create database themes to see spatial data and database tables to see nonspatial or tabular data in ArcView.

Database Access 2.0 added substantially enhanced access to ODBC-compliant databases as well as significantly improved access to Spatial Database Engine™ (SDE®) data. In addition to selection support, selection-enabled database tables now always display all of the records returned from a query instead of just an initial subset to which additional records can be added. The database table also exists entirely in memory and is no longer cached to disk. This is accomplished by maintaining a subset of records in memory and adjusting the subset as the table is scrolled.

Database Access 2.1c is the latest version of the ArcView Database Access extension. Database Access 2.1c expands the data reading capabilities of ArcView 3.3, allowing it to connect to an ArcSDE 8.1 spatial data server. The biggest change with Database Access 2.1c is the new Direct Connect feature. Using the ArcSDE Direct Connect configuration option, ArcView 3.3 can connect to spatial data on Oracle or SQL Server without an ArcSDE application server being present. Direct Connect with Database Access 2.1c requires an ArcSDE server connection license. Database Access continues to support SDE 3.0.x and ArcSDE 8.1.x.

**Dialog Designer Extension**

The Dialog Designer extension provides Avenue developers with tools for customizing the ArcView interface. With this extension, you can create specialized input forms, organize related tools in separate dialogs, add buttons directly to your view or layout, and link what is displayed to your data. The extension supports the display of symbols in list and combo boxes. Multiple rows and columns in a list box are also supported.
Digitizer Extension

The Digitizer extension has been enhanced to support stream mode digitizing. Using this method, you click only the first vertex and simply trace over the feature on a paper map. When you complete tracing the feature, you click another button to end the line. ArcView automatically adds vertices based on a stream tolerance distance that you specify in the current map units. Stream mode digitizing makes it quick and easy to capture complex features, such as streams, rivers, and contours, from the paper map. When you load the Digitizer extension, ArcView adds two new choices to the View menu: Stream Tolerance and Enable/Disable Stream Mode.

Stream Tolerance

When you trace features over the paper map in stream mode, ArcView automatically adds vertices at a specified interval. You can set this interval in current map units and change the distance at any time, even while tracing an existing line. You can also specify the stream tolerance distance interactively using the Stream Tolerance tool in the toolbar. (The Stream Tolerance tool allows you to interactively perform the same functions as the Stream Tolerance menu choice.)

Enable/Disable Stream Mode

This menu item allows you to switch between digitizing in point mode and the new enhanced method of digitizing in stream mode. The default option is point mode digitizing. You may also use the F3 function key to switch between the two modes.

The Digitizer extension is not available on UNIX.

GeoProcessing Extension

The wizard-based interface in this extension lets you perform some new spatial analysis functions in ArcView. To access the GeoProcessing extension, load the extension using the Extensions dialog. Make sure a View is open and active. Then, from the View menu, choose GeoProcessing.
The following functions are provided for each GeoProcessing function.

**Dissolve Features Based on an Attribute**
This process will aggregate features in a theme based on an attribute of that theme. For example, Dissolve could be used to create a theme showing sales regions by salesperson, where each salesperson is responsible for several counties. Sales territories could be established by removing shared county boundaries from those counties represented by the same salesperson.

**Merge Themes Together**
This process will append two or more themes into one theme. The merge process creates a new theme using the fields from the theme you select. If the other themes to be merged have more fields than the theme you have specified, those fields will not be in the new theme's table. If the other themes do not have the same fields as the specified theme, empty cells will be added to the new theme's table. For example, you could merge several tiled county themes with census data to make a single metropolitan area.

**Clip One Theme Based on Another**
This process creates a new shapefile by using one theme (the clip theme) like a cookie cutter on another theme (the input theme). For instance, you might use a county boundary from a counties theme to clip a roads theme. This would create a new theme containing only the roads that fall inside the county boundary.

**Intersect Two Themes**
This process computes the geometric intersection of two themes and adds it to your view as a new theme. The two spatial data sets are integrated, but only the features that fall within the spatial extent common to both themes are preserved. For example, suppose you are a real estate developer and want to build a retirement center within the city boundaries. You can create a theme that assigns land use information (i.e., building codes) to your parcel data so you can look for areas meeting the requirements for multifamily dwellings.

**Union Two Themes**
The Union process creates a new theme by overlaying two polygon themes. The output theme contains the combined polygons and attributes of both themes. Suppose you want to analyze the erosion potential of soils in a given area. Some combinations of slope and soil type represent high risk for erosion, and knowing where these conditions...
exist enables risk assessment of crops. You have one theme with boundaries of slope and another with soil type data. You use Union to create a new theme that contains the spatial combination of information with attribute data, permitting evaluation of erosion potential.

**Assign Data by Location**

The assign data by location operation performs a spatial join between two selected themes. A spatial join is similar to an attribute join; however, it is based on the spatial relationship between the features in the two themes. For example, a travel agency concerned about client safety might assign data from a theme of hotels in a major city to a theme of crime events. The hotel data would be added to the crime event data, along with the distance to the hotel nearest the crime event. As a result, the hotels nearest the most crimes may not be recommended to the travel agency's safety-conscious clientele.

**Graticules and Measured Grids Extension**

Graticules and grids are used to show latitude and longitude on a reference map such as a navigational chart, regional map, or topographic map. Using a set of easy-to-use wizard panels, you can create a grid, graticule, or both. If you are not satisfied with the best-guess evaluation of ArcView for settings, you can customize them yourself.

Customization options include the ability to show only graticule lines and labels or create a full or partial grid. There are also options for choosing the font style and label size. The interval between graticule lines can be adjusted by changing the settings for degrees, minutes, and seconds. If you are showing graticule lines, you can set the line width and color.

Like graticules, you can also adjust display settings for a measured grid. The grid interval, again, is initially estimated by ArcView, and you can choose to display your grid as tics or as a set of intersecting lines. Line width, color of grid tics and lines, as well as font, font size, and style for labels can be adjusted as desired. Border options, including line color and style, are also available.

To access the Graticules and Measured Grids extension, load the extension using the Extensions dialog under the File pulldown menu. You must have at least one view frame.
in your layout before the Graticules and Measured Grids extension is enabled. Click the Graticule and Measured Grids button on the ArcView toolbar to display the first wizard panel.

**ERDAS IMAGINE Image Extension**

This extension provides support for ERDAS IMAGINE images. ArcView 3.3 supports ERDAS IMAGINE 8.5 for Windows and UNIX.

Support for the ERDAS IMAGINE image format has been enhanced to support reading of pyramid layers. Pyramid layers allow for quick display of large images. The extension can only read pyramid layers already created for an IMAGINE image. Pyramid layers can be created using ERDAS IMAGINE or ESRI ArcGIS™ products.

**JPEG (JFIF) Image Support Extension**

This extension provides support for JFIF images, the public domain image file format for JPEG-compressed images.

**Legend Tool Extension**

This extension allows you to create a custom graphical legend in a layout using a set of user-friendly wizard panels. You can create a legend for any view in your project, choose which themes you want shown, and select how many columns to use to display symbols and labels. Other wizard panels allow you to change legend titles, choose settings for legend borders, designate how legend symbols are represented, and set the spacing between legend elements. You can preview your legend at any time. This extension is derived from MapTools, the sample extension previously included in ArcView.

To use the Legend tool, select the Legend Tool extension from the Extensions dialog under the File menu. The Legend tool will appear on the toolbar once you have a layout that contains one or more views. Click the Legend tool, then the layout.

**Military Data Reader Extensions**

The Military Data Reader extensions allow ArcView to recognize a variety of image data formats, typically of interest to the defense/intelligence community, as direct read image data sources. No translation is required to use these image data sources. Once
What's New in ArcView 3.1, 3.2, and 3.3

the proper extension for each image format is loaded, you can use these image data 
sources with ArcView like any other supported image data source. The Military Data 
Reader consists of multiple extensions that you can use in any combination. These 
extensions include support for the following formats:

- ARC Digitized Raster Graphics (ADRG Image Support extension)
- Compressed ARC Digitized Raster Graphics (CADRG Image Support extension)
- Controlled Image Base (CIB Image Support extension)
- National Image Transfer Format (NITF Image Support extension)—NITF image 
support at ArcView 3.3 has been enhanced to read all images in .ntf format as well as 
rotated NITF images. A sample script to read annotation is also included.

MrSID Image Support Extension

MrSID™ is a multiresolution wavelet-based image format that allows a high 
compression ratio and fast access of large amounts of image data at any scale. Support 
for the MrSID image format was added as an example of using the ImgDLL class that 
allows image formats to be added to ArcView. When you load the MrSID Image Support 
extension, you can add .sid files to views as image themes.

Report Writer Extension

The Report Writer extension integrates the industry-leading Crystal Decisions’ Crystal 
Reports report generating and editing application with the existing ArcView Table, 
View, and Project user interfaces. The goal of the ArcView Report Writer interface is 
to streamline the process of data selection and preparation for the reporting process. 
ArcView provides a report wizard that lets you choose the type of report you want, 
choose whether you want to use all the records in the table or only the selected records, 
and specify the output report name. Then the report wizard starts the Crystal Reports 
application with your data already loaded so you can easily continue designing your 
report.

ArcView 3.3 includes Crystal Decisions' Crystal Reports 8.5. With the ArcView report 
wizard, you can choose one of the following report types:

- Quick Report
- Standard Report
- Form Letters
- Mailing Labels
- Top Number (N) Report
- Cross-Tab Report
- Drill-Down Report
- A report based on another template

Note: If you do not have Crystal Decisions' Software's Crystal Reports installed on your 
system, you can still create a simple report with ArcView using Quick Reports. The 
Quick Reports option does not use Crystal Decisions' Software's Crystal Reports and is 
available after any installation of ArcView. The Quick Reports interface provides basic 
tools for selection and organization of fields; setting fonts, column width, and row 
heights to be used in the report; and previewing and printing the report.
TIFF 6.0 Image Support Extension

The TIFF 6.0 Image Support extension allows you to add version 6.0 TIFF files to Views as image themes and place them on Layouts in picture frames. TIFF 6.0 image support includes the use of GeoTIFF 1.0 tags to properly place the image in the proper geographic space, if present.

VPF Viewer Extension

VPF Viewer extension allows you to work with vector product format (VPF) data in ArcView. Using this extension, you can integrate VPF databases into your work seamlessly without having to convert these files into ArcView shapefile format.

The VPF Direct Read function has the ability to add valid three-dimensional VPF themes as three-dimensional type files. A valid three-dimensional VPF theme is one where there are no null Z values present in the coordinate geometry. If any null values are found in the geometry, the theme will be added to the view as a two-dimensional type file. The VPF Direct Reader will automatically detect whether a VPF theme is three dimensional and add it accordingly. To view the shapefiles in three dimensions, you must have the ArcView 3D Analyst extension loaded.
### Optional Extensions to ArcView

**ArcView 3D Analyst Extension**

The ArcView 3D Analyst extension provides a suite of high-quality, easy-to-use tools for creating, analyzing, and displaying surface data. This extension's unique capabilities include support for the triangulated irregular network (TIN) data model, three-dimensional shapes, and interactive perspective viewing.

### ArcPress for ArcView Extension

ArcPress™ software is a graphics metafile rasterizer that enhances the printing and exporting capabilities of ArcView. ArcPress takes an ArcView layout, rasterizes the data, and lets you set a variety of output, page, and print options.

### ArcView Business Analyst Extension

The ArcView Business Analyst extension is a unique set of GIS tools and data designed specifically for business applications. ArcView Business Analyst lets users easily create and analyze market areas, perform site prospecting, profile customers and prospect for similar ones, conduct drive-time analysis, and create detailed reports. This extension captures the power of sophisticated data analysis through an easy-to-use wizard interface that guides you through your crucial business tasks. Included with the software is a comprehensive nationwide suite of business, household, demographic, and street data as well as the ArcView Network Analyst extension and the ArcView StreetMap™ extension.
The ArcView Business Analyst extension is not available on UNIX.
Developed in close collaboration with leading image-processing software vendor, ERDAS, Inc., the ArcView Image Analysis extension provides easy-to-use analysis tools that allow you to display, enhance, and analyze remotely sensed imagery.
ArcView Network Analyst Extension

The ArcView Network Analyst extension enables you to use geographic networks (such as streets, highways, rivers, pipelines, or electric lines) to solve problems such as finding the best travel route, generating travel directions, finding the closest emergency vehicle or facility, or defining service areas based on travel time. Network data used with this extension can come from any of the following sources: ArcView line shapefiles, ArcInfo network or regular line coverages, and CAD drawings.
The ArcView Spatial Analyst extension provides tools to create, view, query, and analyze map cell-based raster data and to perform integrated vector–raster analysis using feature-based and grid-based themes. Capabilities include conversion of feature themes to grid themes, creation of buffer distance and proximity surfaces from feature or grid themes, contouring and density mapping from themes containing point features, slope and aspect mapping, cell-based map analysis, Boolean query on multiple grid themes, neighborhood and zone analysis, and grid classification and display. The extension includes an extensive Avenue programming interface for developing spatial analysis applications.
ArcView StreetMap Extension

The ArcView StreetMap extension adds nationwide address geocoding and street map display to ArcView and includes a compressed street and landmark database for the entire United States on a single CD. The StreetMap extension uses data sources from Wessex Streets 6.0. Wessex, a division of Geographic Data Technology, Inc. (GDT), enhances TIGER 97 by removing the telltale TIGER "wiggle" that results in streets that are not straight. StreetMap data is in NAD83 coordinates.

The ArcView StreetMap extension is not available on UNIX.

ArcView StreetMap 2000 Extension

The ArcView StreetMap 2000 extension is enhanced StreetMap software developed jointly by ESRI and GDT. ArcView StreetMap 2000 supports nationwide address geocoding and street map display. This extension uses GDT’s Dynamap/2000® database, released in January of 1999, and GDT’s Matchmaker® geocoding engine. GDT’s Matchmaker geocoder offers traditional geocoding capabilities and allows the matching of intersections and addresses composed of alphanumeric notations. An Interactive Matcher dialog box displays addresses that failed to match, explains the problem, and suggests possible alternatives. Additionally, state boundaries, cities, airports, hospitals, parks, lakes, and river data are integrated into the display of the data found on the CD. ArcView StreetMap 2000 data is in NAD83 coordinates.

The ArcView StreetMap 2000 extension is not available on UNIX.
ArcView Tracking Analyst Extension

The ArcView Tracking Analyst extension can be used by anyone who needs to view and analyze the movement and status of objects through time. Developed in close collaboration with TASC Inc., a major provider of advanced information technology solutions for governments and businesses worldwide, ArcView Tracking Analyst supports real-time global positioning system and network connections, allowing you to map events in real time. For example, you could follow your delivery vehicles on their daily routes, track weather conditions such as hurricanes or lightning, or study the migration routes of animals.

The ArcView Tracking Analyst extension requires ArcView 3.1 or higher and is available on Windows 95/98®, Windows NT® 4.0, 2000, and XP; and Solaris™.

ESRI Data & Maps

ArcView 3.3 includes the ESRI Data & Maps 2002 CDs with eight CDs of data.

There are two major areas of change in the 2002 version of the Data & Maps CDs. The first involves updating more than 450 metadata files to provide full compatibility with the new ArcIMS® 4 Metadata Server.

The second major change is that all layers of census geography were updated to be current with Census 2000. All the county, city, place, tract, block group, and block locations have been updated with the most current TIGER or GDT boundary files. All census-derived attributes have been updated with the current Census 2000 Summary File 1 (SF1) and/or Public Law 94 (PL94) attribute values. New year 2001 population estimates are provided from ESRI Business Information Solutions (ESRI BIS, formerly CACI Marketing Services Group) for most of the census geographies, and the Census of Agriculture attributes for states and counties were updated to 1997.
Other U.S. updates include the 107th Congressional District boundaries as well as new five- and three-digit ZIP Code boundaries current to January 2002. For the world data, international boundaries and time zones have been updated to reflect recent changes. For more details regarding the data, refer to the *ESRI Data & Maps 2002* white paper.

### Samples

The samples directory contains a rich resource of sample programs you can use directly in your work or study to learn more about customizing ArcView. There are three kinds of samples in the samples library: Avenue scripts, extensions, and other sample programs. For a listing and description of samples in this directory, refer to "Sample scripts and extensions" under the Contents tab in the help topics.

The extensions are located in the $AVHOME\samples\ext directory in your ArcView installation.

### ArcView Connect for R/3 Extension

The ArcView Connect for R/3® sample extension allows you to initiate SAP™ R/3 function modules from ArcView. Using this extension, you can download R/3 data into ArcView for visualization and spatial analysis as well as interact with SAP R/3 on a transactional basis. This extension allows you to immediately utilize R/3 standard functions and provides a flexible tool to build custom applications that require ArcView and SAP R/3 connectivity.

ArcView Connect for R/3 will quickly allow, for example, a download of customer information from R/3. If the customer data has address information, it can be geocoded, displayed, and analyzed with any other spatial data using ArcView. ArcView Connect for R/3 can also be used to access data stored in several other SAP modules such as Materials Management (MM), Plant Maintenance (PM), Sales and Distribution (SD), Asset Management (AM), Service Management (SM), and others.

This extension uses a generic Dynamic Link Library (DLL) that was built using the SAP C++ Developer Kit. The DLL is wrapped in a Visual Basic® (VB) GUI and allows communication to SAP R/3 via the SAP Remote Function Call (RFC) libraries. All source code for the VB example interface application is provided as part of the extension.

The extension requires a standard installation of Samples. Its file name is esrir3.avx and is located in the $AVHOME\samples\ext\esrir3 folder.

### ArcView R/3 Interface Project

The ArcView R/3 Interface is a sample project that enables ArcView to communicate with the MM and modules of SAP R/3. The ArcView R/3 Interface can also be customized and extended to work with other R/3 modules and to present more options to the user within ArcView.

### Map Labeling Extension

This sample extension adds a choice to the Theme menu that gives you an interface for labeling one or more themes so placement conflicts between labels will be resolved for all labels, regardless of what theme the label belongs to. The interface allows you to set priorities and rules for each theme that goes into the labeling process. For example, you can assign a different font to each theme.
The extension requires a standard installation of the Samples. Its file name is multmlab.avx and is located in the $AVHOME\samples\ext folder.

**MGE Reader Extension**

This sample extension allows you to integrate data created in Intergraph's MGE software or Bentley's MicroStation® GeoGraphics software. You can also use data in MicroStation design files linked directly to external tables, and ArcView will manage the linkages for you. ArcView presents this data in a manner familiar to ArcView users while maintaining many tools and features of the native software. You can symbolize, query, and analyze the data just like any other spatial data without converting the data to shapefile format. This allows you to view the most up-to-date data in ArcView, while the underlying data is updated in the native software.

This extension requires a standard installation of the Samples and is dependent on the CAD Reader extension. The file name is MGEView.avx, and it is located in the $AVHOME\samples\ext folder.

**DIGEST (ASRP/USRP)**

This sample extension provides direct read support for raster data compliant with DIGEST Annex A, a format primarily used by international defense and military agencies. The reader georeferences DIGEST images. There are two profiles: Arc Standard Raster Product (ASRP), produced by the UK Mil Survey, and UTM/Universe Polar Stereographic (UPS) (USRP), produced by the French Defense Mapping Agency. The sample extension supports ASRP 1.1 and 1.2 and USRP 1.2 and 1.3.

**MGRS Coordinate Display**

This sample extension provides interactive display of coordinates on-screen in the Military Grid Reference System (MGRS). MGRS is a coordinate system widely used in defense for designating the location of points of interest. Its use is especially prevalent in the army. The extension supports the coordinates as defined in the Army Handbook for the Transformation of Datums, Projections, Grids, and Common Coordinate Systems by the U.S. Army Corps of Engineers Topographic Engineering Center, January 1996.

The extension reads source data in decimal degrees, converts the coordinates to MGRS, and displays the MGRS coordinates in a dialog box in real time. The extension converts and displays the MGRS coordinates to UTM/UPS and latitude/longitude. As an option, you can save the UTM/UPS and latitude/longitude coordinates in a separate file. The utility also generates graticules within an MGRS zone for WGS84.

**S-57 Data Converter**

The S-57 data format is defined in the International Hydrographic Organization's Special Publication S-57. This format was formerly referred to as DX-90. S-57 is object-oriented vector data stored in binary format. This sample extension converts the converted binary S-57 (ENC) data to ArcView shapefiles. The extension supports all data types from S-57: spatial objects (connected nodes, isolated nodes, edges, and faces) and feature objects (points, nodes, lines, areas, and composites).

The UNIX version of the S-57 converter is only available on Solaris.
RPF Indexer

Raster Product Format (RPF) is one of the NITF's formats. CIB and CADRG are RPF products.

This sample extension uses the geographics extent of each RPF data set and generates a shapefile that can be used as an index theme for RPF image formats. The index theme helps the user choose the images of interest for easier display. The user selects a block or draws a box on the index theme in the View document to display the corresponding images. The user can click on the block (or user-drawn box) again and the images will undraw.
For more than 30 years ESRI has been helping people manage and analyze geographic information. ESRI offers a framework for implementing GIS technology in any organization with a seamless link from personal GIS on the desktop to enterprisewide GIS client/server and data management systems. ESRI GIS solutions are flexible and can be customized to meet the needs of our users. ESRI is a full-service GIS company, ready to help you begin, grow, and build success with GIS.

Corporate

ESRI
380 New York Street
Redlands, California
92373-8100, USA
Telephone: 909-793-2853
Fax: 909-793-5953

For more information on ESRI, call
1-800-447-9778 (1-800-GIS-XPRT)
or contact an ESRI reseller near you.

Send e-mail inquiries to
info@esri.com

Visit ESRI’s Web page at
www.esri.com

Regional Offices

ESRI–Olympia
360-754-4727
ESRI–St. Louis
636-949-6620
ESRI–Minneapolis
651-454-0600
ESRI–Washington, D.C.
703-506-9515
ESRI–Boston
978-777-4543
ESRI–Charlotte
704-541-9810

ESRI–California
909-793-2853
ext. 1-1906
ESRI–Denver
303-449-7779
ESRI–San Antonio
210-499-1044

International Offices

Australia
613-9867-0447
Belgium/Luxembourg
32-2-460-7480
Bulgaria
359-2-964-0850
Canada
416-441-6035
France
33-1-46-23-6060

Germany/Switzerland
49-8166-677-0
41-1-360-2460
Hong Kong
852-2730-6883
Hungary
361-428-8040
India
91-11-620-3802
Indonesia/Malaysia
62-21-570-7685
603-7874-9930

Italy
39-06-406-96-1
Japan
81-3-3794-6681
Korea
82-2-571-3161
Netherlands
31-1-46-23-6060
North America
978-777-4543

Singapore
65-742-8622
Spain
34-91-559-4375
Sweden
46-23-755-400
Thailand
66-2-678-0707

United Kingdom
44-1296-745-500
Venezuela
58-212-285-9394

Outside the United States, contact your local ESRI distributor.
For the number of your distributor, call ESRI at 909-793-2853, ext. 1235,
or visit our Web site at
www.esri.com/international

Place ESRI business partner or distributor address here.